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Akceptowane formaty plików

– zamknięty plik kompozytowy – PDF do druku zapisany do standardu PDF/X:
PDF/X-1a (nie obsługuje przezroczystości), PDF/X-3 lub PDF/X-4. Przy zapisie do PDF/X stosować 
domyślną kompresję jpeg maximum lub ZIP.
– plik w przestrzeni kolorystycznej CMYK + ewentualnie dodatkowe separacje Pantone (ilość zgod-
na z zamówieniem)
– prawidłowo zdefiniowany trimbox i bleedbox
– format netto wyśrodkowany na formacie brutto
– rozdzielczość bitmap min. 300 ppi, w przypadku grafiki wektorowej – ustawienia rastra dokumentu: 
300 ppi. Dla bitmap za bezpieczne powiększenie bez wyraźnie widocznej utraty szczegółów przyj-
muje się max. 130% oryginału.
– czcionki osadzone w pliku, nie zaleca się zamiany tekstu na krzywe, chyba że osadzenie nie jest 
możliwe z powodu ograniczeń licencyjnych. Czcionek nie należy też zamieniać na bitmapę. Skutkuje  
to gorszą jakością w druku.
– najmniejsza dopuszczalna grubość linii to 0,15 pkt
– siatka rozrysu zdefiniowana w kolorze dodatkowym (Pantone) i jako odrębna separacja (w pliku 
kompozytowym), z zadanym overprintem

Zarządzanie kolorem

– w celu zapewnienia zgodności kolorystycznej, pliki powinny być przygotowane z użyciem profilu 
ISO Coated v2 ECI oraz ISO Coated v2 300% ECI (dotyczy kart). Przed przystąpieniem do pracy 
nad projektem należy ustawić zalecany profil dla przestrzeni roboczej dokumentu. Nasycenie kolo-
rów, czyli suma składowych CMYK, wynosi 330% dla ISO Coated v2 ECI oraz 300% dla ISO Coated 
v2 300% ECI. Oba profile dostępne są na stronie www.eci.org i na FTP.
– nafarbienie dla papierów powlekanych: 330%, dla niepowlekanych: 290%
– w celu uzyskania głębokiej czerni apli, kolor czarny należy wzmocnić z triady CMYK. Zalecany 
skład czerni CMYK: 50-40-40-100.
– czarne elementy graficzne i teksty powinny składać się z jednego koloru (CMYK: 0-0-0-100)  
z włączonym trybem nadruku (overprint). Szare elementy na kolorowym tle lepiej zamienić na sza-
rość z triady CMYK.
– cienkie linie (poniżej 0,75 pkt.) lub elementy grafiki (np. kratka) należy opracować w jednym kolo-
rze, pozwoli to uniknąć niedokładności pasowania w procesie druku

Nadrukowywanie i zalewkowanie

– czarny tekst (100%K) o wielkości czcionki do 14 pkt należy nadrukowywać na tło (overprint)
– tekst o wielkości czcionki poniżej 14 pkt należy zalewkować (trapping). Zalecana wielkość zalew-
kowania: 0,25 do 0,5 pkt.
– dla wszystkich elementów (w tym tekstu), które mają być drukowane na tle wykonywanym farbą  
kryjącą (w tym metaliczną), musi być zastosowane wybranie tła oraz zalewkowanie na krawędziach  
obiektów. Zalewki należy wykonać w ten sposób, aby powiększały obrys netto obiektu zalewkowa-
nego. 

Zasady przygotowania materiałów do druku  
w TREFL SA

Pliki przekazane do elektronicznego montażu powinny być zgodne z zamówieniem, merytorycz-
nie sprawdzone i zatwierdzone przez Klienta. Poprawki dokonywane w gotowych już montażach 
mogą spowodować opóźnienie terminu produkcji i wygenerować dodatkowe koszty. Pliki graficzne 
przygotowywane są przez Klienta według siatek (rozrysów) przesłanych przez Trefl. W przypadku, 
gdy Klient sam przygotowuje rozrys (dotyczy formatek), rozrys ten musi uwzględniać technologię 
produkcji (odstępy między nożami, spady wewnętrzne i zewnętrzne).

http://www.eci.org/en/downloads
ftp://e.nowaczyk:GupRBxfY@ftp.trefl.com/PL/
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Stosowanie oznaczeń na produkcie. Kody EAN

– stosowanie oznaczeń na produkcie jest określone przez prawo handlowe (Dyrektywa 2009/48/we),  
symbole te nie podlegają modyfikacjom, albo zakres modyfikacji jest ściśle określony.
– informacje, jakie oznaczenia wymagane są dla danej grupy produktów, znaleźć można w pliku 
instruktażowym na FTP, natomiast treść dyrektywy jest dostępna pod linkami (link1, link2).

– zasady umieszczania kodów kreskowych, ich skalowania oraz dopuszczalnej kolorystyki są ściśle 
określone przez normy, które można znaleźć na stronach www dotyczących specyfikacji kodów  
EAN. Kodów kreskowych nie należy zamieniać na bitmapę i opracowywać w CMYK, niesie to  
ryzyko błędu odczytu kodu. Należy pamiętać też o obszarze ciszy wokół kodu – powinien być 
umieszczony na białym polu, nie bezpośrednio na grafice.
– drobne symbole i logotypy należy umieszczać jako obiekty wektorowe. Nie należy zamieniać ich 
na bitmapę.

Spady wewnętrzne i zewnętrzne. Pliki instrukcji

– spady wewnętrzne dotyczą wszystkich sztancowanych elementów i wynoszą 3mm do wewnątrz 
użytku
– minimalne spady dla pudełek, formatek, instrukcji: 3mm, minimalne spady dla plakatów puzzlo-
wych: 5mm
– instrukcje, broszury, książeczki wraz z okładką powinny zawierać się w jednym pliku w kolejności 
od pierwszej do ostatniej strony, nie należy przysyłać stron jako rozkładówki. Łączenie stron w pary 
następuje na montażu impozycyjnym.
– instrukcje powyżej 4 stron powinny zawierać paginację

Przed przekazaniem plików do drukarni:
Należy bardzo uważnie sprawdzić projekt, a w szczególności wykonać:
– podgląd separacji barwnej – jeśli kolory separują się nieprawidłowo, są błędy w nadruku, wybraniu  
tła i zalewkowaniu, pliki będą cofane do poprawy 
– sprawdzenie obecności spadów po wygenerowaniu pliku PDF 
– sprawdzenie merytoryki pracy, ewentualnych błędów wyświetlania, literówek, wiszących spójni-
ków, poprawnej orientacji awersów i rewersów

Po otrzymaniu pdfów impozycyjnych:
– PDF z montażem należy zapisać na dysku komputera, nie zaleca się oglądać plik przez przeglą-
darkę internetową
– w przypadku błędów w wyświetlaniu PDF, plik należy oglądać w dużym powiększeniu
– montaż należy uważnie sprawdzić pod kątem poprawności wykonania: czy zgadza się ilość użyt-
ków, czy awersy zgadzają się z rewersami, czy linia rozrysu przebiega zgodnie z zamysłem autora 
projektu.

litery duże, pogrubione,
wysokość liter z uwzględnieniem 
kropki w „Ż” minimum 2,5 mm

wysokość liter minimum 1,5 mm

WAŻNE! symbol buźki, ostrzeżenie i tekst tego ostrzeżenia występują jako jeden znak,  
elementy nie powinny być stosowane wybiórczo

minimalna wysokość 5 mm,
kształt nie podlega modyfikacji,
kolor dowolny

kształt nie podlega modyfikacji,
wielkość i kolor dowolne

średnica symbolu minimum 10 mm,
koło i przekreślenie w kolorze czerwonym, 
tło białe, oznaczenie wieku i zarys buźki czarne

ftp://e.nowaczyk:GupRBxfY@ftp.trefl.com/PL/
http://eur-lex.europa.eu/legal-content/PL/TXT/HTML/?uri=CELEX:32009L0048&from=EN
http://www.me.gov.pl/files/upload/14175/TSD-rev1-7-explanatory-guidance-document-pl.pdf
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Przygotowanie projektu na pudełko na siatce wykrojnika

1) WIEKO i DENKO należy przygotować na osobnych stronach. Każda z nich powinna mieć  
właściwie zdefiniowany trimbox i bleedbox.
2) Siatka wykrojnika powinna być opracowana w trybie CMYK dokumentu, linia siatki jako 5ty kolor  
(z palety kolorów dodatkowych) z włączonym trybem nadruku obrysu (overprint stroke), siatka ta 
nie będzie drukowana, ma tylko pomóc w montażu impozycyjnym, grubość linii należy ustawić na 
najcieńszą dostępną w programie (np. 0,25 pkt).

3) Rozrysu pudełka nie należy modyfikować (skalować, przesuwać czy usuwać linie). W przypadku 
otrzymania rozrysu z wiekiem i denkiem na jednej stronie oraz podpisanymi wymiarami dla po-
szczególnych elementów siatki, należy wydzielić osobno wieko i denko, usunąć wymiary i strzałki,  
i opracować siatkę w trybie CMYK dokumentu. 

WIEKO i DENKO w stanie surowym - pdf w trybie RGB, z podpisanymi wymiarami, wieko i denko na jednej stronie dokumentu.

WIEKO i DENKO opracowane - dokument w trybie CMYK, wieko i denko opracowane osobno, wycentrowane na stronie  
z prawidłowo ustawionym spadem dokumentu, linia rozrysu ustawiona na najcieńszą i jako 5ty kolor z włączonym nadrukiem.

WIEKO, DENKO - OKLEJKA:
   
WIEKO i DENKO należy przygotować na osobnych stronach. Po otrzymaniu pliku z rozrysem należy 
najpier oddzielić WIEKO od DENKA. 

1) Otwieramy otrzymany plik PDF z rozrysem w Adobe Illustartor

2) Zmieniamy tryb koloru dokumentu na CMYK
     File - > Document Color Mode - > CMYK Color

Przykład przygotowania SIATKI pod projekt w programie Adobe Illustartor

PUDEŁKA

tryb 
koloru

dokumentu

- W przypadku DENKA postępujemy analogicznie jak w przypadku WIEKA:
  Sprawdzamy wymiary, dodajemy stronę i suatwiamy wymiary strony takie jak wymiary siatki DENKA.

  Siatki WIEKA i DENKA wysrodkowane na stronach 1 i 2

- Teraz należy ustawić spad dla stron, który powinien wynosić minimum 3mm. Spad ustawiamy 
   w oknie opcji dokumentu, które przywołujemy przez góne menu : File - > Document Setup,
   przy pozycji Bleed:

Ustawienia
spadów strony
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4) Projekt na WIEKO i DENKO musi uwzględniać technologię produkcji (spady do wewnątrz i na 
zewnątrz siatki wykrojnika; zawijkę).

Spad wewnętrzny i zewnętrzny wynosi minimum 3mm.

Spad wewnętrzny to minimalna bezpieczna odległość grafiki/tekstu od linii zagięcia. Jeśli odległość  
grafiki/tekstu od linii siatki będzie zbyt mała, to w wyniku przesunięć podczas oklejania w procesie  
produkcyjnym może się on znaleźć w miejscu zagięcia.

Spad zewnętrzny to minimalna bezpieczna odległość grafiki/tekstu od linii cięcia. Jeśli odległość 
grafiki/tekstu od linii siatki będzie zbyt mała, to element może zostać obcięty.

Wewnątrz obszaru oznaczonego czerwoną linią przerywaną powinny się zawierać tekst  
i grafika. Wyjątek stanowią mniej istotne elementy grafiki wypuszczone na spad, np. postać  
umieszczona z boku pudełka wykadrowana do pasa.

Obszar zaznaczony zieloną linią przerywaną to tzw. trimbox. Trimbox wyznacza obszar 
netto użytku, czyli po obcięciu spadów (bleedbox). Jego wymiar jest równy wymiarowi siatki  
użytku.

Dla siatki wykrojnika należy ustawić najcieńszą grubość linii, wybrać dowolny kolor z zes- 
tawu kolorów dodatkowych Pantone oraz włączyć tryb nadruku obrysu (overprint stroke). 
Siatka powinna być wycentrowana względem grafiki, a spad z każdej strony wynosić tyle 
samo.

Wewnątrz obszaru oznaczonego czerwoną linią przerywaną powinny się zawierać
tekst i grafika. Margines do linii gięcia powinien wynosić minimum 3mm. Wyjątek stanowią
elemnty grafiki, które maja być wypuszcone poza obszar na spad, np postać umieszczona 
boku pudełka wykadrowana do pasa.

Obszar zaznaczony zieloną linią przerywaną to tzw Trimbox.
Trimbox wyznacza obszar netto użytku, czyli po obcięciu

Dla siatki wykrojnika należy wybrać dowolny kolor z zestawu kolorów dodatkowych Pantone
oraz włączyć tryb nadruku obrysu (overprint stroke)

spad 
wewnętrzny
min. 3mm

spad 
zewnętrzny
min. 3mm
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SIATKA
WYKROJNIKA
Kolor spacjalny
tryb nadruku (overprint) 

                     Schemat do poprawnego projektu na siatce wykrojnika.

1) W przypadku pudełka o róznych kolorach boków obszary tła nalezy łączyć ze sobą 
    wg. ponizszego wzoru.
2) Należy pamiętać o tzw spadzie wewnętrznym i zewnetrznym wynoszącym min 3mm. 
    Spad wewnetrzny to minimalna bezpieczna odległość grafiki, tekstu od linii zagięcia. Jeśli odległosć
    grafiki/textu od linii siatki będzie zbyt mała, to w wyniku przesunięć podczas oklejania w procesie 
    produkcyjnym może się on znaleźć w miejscu zagięcia.
    Spad zewnetrzny to minimalna bezpieczna odległość grafiki, tekstu od linii cięcia. Jeśli odległosć
    grafiki/textu od linii siatki będzie zbyt mała, to elment może zostac obcięty.
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OKLEJKA po przycięciu

OKLEJKA przed przycięciem
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Oklejone WIEKO

C) Część odcięta

Zawijka
Oklejone wieko (widok od spodu)

Oklejone wieko

Opracowanie narożników pudełka

3

W przypadku pudełka o różnych kolorach boków obszary tła należy łączyć ze sobą według wzoru  
po prawej. WAŻNE! Oklejka jest przycinana wzdłuż linii ciągłej na przykładzie poniżej, linia przery-
wana to siatka szkieletu pudełka.  
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ZAWIJKA to ta część oklejki, która nachodzi  
na wewnętrzną stronę boków pudełka. 
Obszar zawijki na poniższej siatce został 
zaznaczony kolorem żółtym.

Oklejanie WIEKA, DENKA

miejsce na pasek klejowy 
należy pozostawić białe

W przypadku bardzo małych pudełek (np. puzzle 
mini 54 el., pochewka memo) projekt graficzny  
powinien w szczególny sposób uwzględniać  
specyfikę produkcji maszynowej i możliwość  
wystąpienia przesunięć. Poszczególne ścianki  
pudełka bezpieczniej będzie opracować w jedno-
litej kolorystyce.

Zawijka
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Przygotowanie projektu na planszę

Rozróżniamy 2 rodzaje plansz - oklejaną i na ostro. Pliki na przód i tył planszy powinny być przygo-
towane w zależności od jej typu. Podobnie jak w przypadku pudełek, projekt na planszę powinien 
uwzględniać przesunięcia mogące wystąpić podczas oklejania (wymagane spady wewnętrzne: 3mm  
do wewnątrz pola planszy).

OKLEJKA:
1) Wymiar tektury określa wymiar GOTOWEJ planszy NETTO.
2) Do wymiaru netto należy dodać spad na zawijkę po 17,5 mm z każdej strony, czyli 35 mm łącznie. 
3) Do wymiaru oklejki planszy z zawijką należy dodać jeszcze po 5 mm spadu na obcięcie z każdej  
strony, czyli łącznie 10 mm.

WKLEJKA:
1) Od wymiaru netto planszy (tektury) należy odjąć po 5 mm z każdej strony, czyli wymiar wklejki 
wynosi 10 mm mniej niż wymiar tektury.
2) Do wymiaru NETTO wklejki należy dodać po 5 mm spadu z każdej strony, zatem wymiar brutto 
wklejki (łącznie ze spadami) jest równy wymiarowi tektury.

Plansza oklejana

OKLEJKA

TEKTURA
420x300mm

OKLEJKA planszy netto
455x335mm

OKLEJKA planszy brutto
46 x345mm

WKLEJKA

WKLEJKA planszy netto
410x290mm

WKLEJKA planszy brutto
420x300mm

5 mm

AWERS i REWERS netto mają taki sam wymiar. Do wymiaru netto należy dodać tylko spad  
na obcięcie po 5 mm z każdej strony, czyli łącznie 10 mm.

Plansza na ostro
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6 mm

Odstępy między nożami

Technologia produkcji ma pewne ograniczenia, dlatego przy projektowaniu grafiki na formatkę  
i samodzielnym opracowywaniu rozrysu wykrojnika należy kierować się kilkoma ważnymi zasadami.  
Pozwoli to uniknąć konieczności przerabiania grafiki, jeśli nadesłany do nas rozrys nie będzie 
uwzględniał technologii.

6 mm

6 mm

Minimalny odstęp między nożami dla kartoników, kart memo, żetonów, czy elementów o nieregularnych kształtach to 6 mm.
Minimalny odstęp od sztancowanego elementu do krawędzi formatki to również 6 mm..

OKLEJKA

OKLEJKA

PRZYKŁAD
OKLEJKA przed przycięciem

OKLEJKA po przycięciu

OKLEJONA tektura
widok od strony wklejki

TYŁ PLANSZY z naklejoną wklejką

OKLEJKA

OKLEJKA

PRZYKŁAD
OKLEJKA przed przycięciem

OKLEJKA po przycięciu

OKLEJONA tektura
widok od strony wklejki

TYŁ PLANSZY z naklejoną wklejką

Przykład planszy oklejanej

oklejka przed przycięciem oklejka po przycięciu

oklejona tektura - widok od strony wklejki tył planszy z naklejoną wklejką
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Przygotowanie projektu na formatki

Wymiar elementu netto po wycięciu.

Spad zewnętrzny elementu (+3 mm) uwzględniany, jeżeli element zawiera kolorowe tło.  
W przypadku białego tła elementów, tworzenie lini spadu zewnetrznego jest zbędne.

Bezpieczny obszar (-3 mm), poza który nie może wystawać żaden ważny element grafiki, 
który nie może zostać obcięty. To, który fragment grafiki jest istotny, a który jest mniej istotny  
i może zostać przycięty, ustala autor projektu.

W przypadku FORMATEK z elementami o nie- 
regularnych kształtach precyzyjne wymierze- 
nie grafiki względem elementu nie będzie 
możliwe bez utworzenia linii pomocnicznych 
wyznaczających spady zewnętrzne i wewnę- 
trzne minimum 3 mm.

Najprostszym i najszybszym sposobem na 
wyznaczenie linii pomocniczych jest użycie 
funkcji Przesunięcie ścieżki (Offset path) 
w Illustratorze (Object>Path>Offset Path...). 

Przykład formatki 
z elementami o nieregularnych kształtach:

Elementy formatki
z wyznaczonymi spadami zewnętrznymi i wewnętrznymi:

- W przypadku FORMATEK z elemntami o nieregularnych kształtach precyzyjne wymiarzenie grafiki
względem elemntu nie bedzie możliwe bez utworzenia linii pomocnicznych wyznaczajcych spady 
zewnetrzne i wewnętrzne.
    

   
- Metodą pokazaną na poprzednich stronach tworzymy linie pomocnicze spadu zewnetrznego 
  i wewnetrznego. Należy upewnić się czy ściezki każdego elementu są zamknęte. W przecienym 
 wypadku uzyskamy nieoczekiwany efekt:

    

   

FORMATKI z elemntami o nieregularnych kształtach.
    

   

Niepołączona ścieżka Po zaznaczeniu elemntu widzimy jeden niepolaczony 
odcinek ścieżki.

Przykład FORMATKI z elemntami o nieregularnych kształtach.

Bezpieczny obszar ( -3 mm ) , poza który nie może wystawać żaden ważny element 
grafiki, który nie może zostać obcięty.

Wymiar elementu NETTO po wycięciu.

Spad zewnętzrny elementu ( +3 mm) uwzględniany jeżeli element zawiera kolorowe tło.
W przypadku białego tła elementów, tworzenie linni spadu zewnetrznego jest zbędne.

+3 mm

-3 mm

Przykłady źle i dobrze opracowanej grafiki na elementach formatek 
o różnych kształtach:

ŻLE!
Za mały spad zewnętrzny tła.

Grafika wystaje poza bezpieczny obszar.

DOBRZE!
Prawidłowy spad zewnętrzny.

Grafika nie wystaje poza bezpieczny obszar.

    -  Zaznaczamy siatkę, następnie wchodzimy w górne menu  Object-> Path -> Offset Path...,

    -  Ustawiamy wartość spadów

WAŻNE! Spad 3 mm jest bezwzględnie najmniejszym akceptowalnym spadem, wynikającym 
z ograniczeń produkcyjnych. W przypadku, gdy odstępy miedzy elementami na formatce wy-
noszą więcej niż 6 mm, warto to wykorzystać na większy spad - ułatwi to proces produkcyjny. 
Oczywiście nie należy z tym przesadzać i, jeśli odstepy między elementami wynoszą 15 mm,  
wystarczą spady po 5 mm wokół elementów.

SPAD WEWNĘTRZNY (margines) - jest tak samo ważny jak spad zewnętrzny, gdyż wyznacza 
bezpieczny obszar wewnątrz elementu. W bezpiecznym obszarze powinna zawierać się istotna 
treść graficzna, która powinna się znaleźć w całości w obrębie elementu i nie może uciec z kadru  
w wyniku przesunięć na sztancy w procesie produkcji. Zbyt mały spad wewnętrzny może spowodo-
wać obcięcie istotnej części grafiki. Jeśli wielkość elementu formatki na to pozwala, warto ustawić 
możliwie jak najwiekszy spad wewnętrzny.
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Poniższy przykład gotowej formatki pokazuje elementy grafiki, wystające poza obszar spadu  
wewnętrznego, które w tym przypadku zostały uznane za mniej istotne.

Inna opcja: wypełnienie formatki kolorem w całości. W tym wypadku należy uwzględnić spad  
zewnętrzny całej formatki.

9) Opracowujemy grafikę na przygotowanej siatce, pilnując by ważne fragmenty grafiki nie wystawały
    poza obszar spadu wewnatrznego.
    Który fragment grafiki jest istotny, a który jest mniej istotny i może zostać przycięty ustala autor
    projektu.
    Poniższy przykład gotowej formatki pokazuje elemnty grafiki, wystające poza obszar spadu 
    wewnętrznego, które w tym przypadku zostały uznane za mniej istotne.

   

    -  Przenosimy linie spadów na nową warstwę i zmieniamy jej kolor na dowolny inny
       W opcjach warstwy odznaczamy Print. Do opcji warstwy wchodziny dwukrotnie klikając na niej

odznaczyć

10) Inna opcja: wypełnienie formatki kolorem w całości. W tym wypadku nalezy uwzględnić 
      spad zewnetrzny całej formatki:
    

   

10) Rewers FORMATKI opracowujemy analogicznie, kierujac sie tymi samymi zasadami jak 
      w przypadku awersu.

11) Przed zapisaniem pracy należy się upewnić, czy siatka wykrojnika ma włączaną opcję
      nadruku. Górne menu -> Window -> Separation Preview 
    

   

Zaznaczamy ptaszkiem opcję 
Overprint Preview.
Klikając na ikonce oka możemy 
włączać i wyłączać poszczególne 
składowe kolorów.
Jeśli wyłączając kolor siatki zmienia się
ona na kolor biały oznacza to, że overprint (nadruk)
nie jest włączony i wybiera (wycina) kolory położone
pod nim. Przy włączonym nadruku siatka 
powinna znikać.
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Przykłady źle i dobrze opracowanej grafiki na elementach formatek
o nieregularnych kształtach

Za mały spad zewnętrzny tła.
Grafika wystaje poza bezpieczny obszar.

Prawidłowy spad zewnętrzny.
Grafika nie wystaje poza bezpieczny obszar.

3
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Istotne fragmenty grafiki

Są to te fragmenty grafiki elementu, które w zamyśle autora nie mogą uciec z kadru z wyniku przesu-
nięcia, lub obcięcia w procesie produkcyjnym. Autor sam ustala, który fragment jest dla niego istotny,  
a który może zostać ucięty.

Kielich kwiatu jest dla autora ważny,  
łodyga może zostać obcięta.

Muszka jest dla autora ważna, 
tasiemki mogą zostać obcięte.

Blat i kieliszek są istotne,
nogi stołu mogą zostać obcięte.

Sznurek jest nieistotny dla autora. Korona ważna,
gumka nieistotna.

Metody, których należy unikać

Przesunięcia w procesie produkcyjnym występują zawsze (przesunięcia przy oklejaniu, przy paso- 
waniu awersu z rewersem, przy sztancowaniu). Grafikę należy przygotować tak, aby zminimalizować  
ich widoczność. Na pewno należy unikać stosowania ramek / obwódek w kształcie elementu,  
ponieważ nie da się idealnie spasować awersu z rewersem z powodu ograniczeń możliwości  
maszyn produkcyjnych.

Idealne spasowanie awersu z rewersem nie jest możliwe.

AWERS REWERS AWERS REWERS

3

3
AWERS REWERS AWERS REWERS

Łagodniejszy efekt przesunięcia, mniej rzucający się w oczy, 
daje przykład bez ramek, z tłem wyciągniętym na spad.

Na montażu 
impozycyjnym 

grafika jest zawsze
idealnie wyrównana 

do rozrysu.

Przy obustronnym oklejaniu
tektury formatki pojawia się 

przesunięcie.
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W przypadku, gdy elementy REWERSU zawierają jednakowe i jednolite tło, lepiej zrezygnować  
z wycinania elementów. Ułatwi to proces produkcji oraz złagodzi efekt przesunięć w procesie  
oklejania.

Nie ma również sensu wycinanie obiektów na tle formatki, gdy grafikę stanowi jednolity deseń.  
Lepszym rozwiązaniem będzie wypełnienie całego obszaru formatki deseniem.

3

3
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Pliki na karty należy przygotować według wytycznych fabryki kart. Między innymi należy pamiętać, 
że nasycenie kolorów dla kart nie może przekraczać 300% (profil zalecany ISO Coated v2 300% 
ECI). Jeśli w zamówieniu są przykładowo 2 talie kart, to należy przygotować 4 pdfy produkcyjne: 
 
1) talia #1 awers, 
2) talia #1 rewers, 
3) talia #2 awers, 
4) talia #2 rewers.

Karty

W zamówieniu mogą wystąpić karty spadowe albo niespadowe.  
W zależności od wybranego rodzaju kart, grafikę należy przygotować 
według wytycznych fabryki kart (odrębny plik instrukcji). 

karty spadowe karty niespadowe

Grafika przygotowana z uwzględnieniem 3 mm spadu na przycięcie
albo z kolorową ramką. 

Grafika z uwzględnieniem białej ramki. Ramka w kartach niespa-
dowych może być tylko biała. Inny kolor ramki byłby możliwy,  
ale w karcie spadowej.
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Przykładowy rozrys na kartę 58 x 88 mm

W każdym pliku powinna być ilość i kolejność stron zgodna z ilością  
i kolejnością kart w talii. Jeśli jakieś karty ulegają powtórzeniu,  
to w pliku również należy je powtórzyć w ilości zgodnej z zamysłem 
autora i zamówieniem. Jeśli rewers kart w obrębie 1 talii jest taki sam 
dla wszystkich kart, wystarczy 1 strona w pliku, na montażu zostanie 
ona powielona.


